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1 Modification History

Revision Date Comments
1.0 February 28, 2018 | Initial Release




1.1

March 12, 2018

Described new layout of the header in the Message Window.
Described new global options settable via GUI.

1.2

April 9, 2018

Enhanced search scope to include from, to, subject fields,
message text and text attachments.

Eliminated false negative searches by first decoding base64 and
quoted-printable content blocks.

Enhanced mboxview index file to keep track of text content
blocks to optimize message and attachments search
performance.

Deprecated searching of RAW mail data.

1.3

April 16, 2018

Added Next/Previous search options to Find dialog.
Optimized message text search performance and significantly
reduced number of cases of false positive search results.

1.4

May 5, 2018

Added Picture Viewer dialog to preview attachments with the
png, jpg, jpeg, jpe, gif, bmp, ico, tif, tiff, jfif, emf, wmf, dib
suffixes.

The Picture Viewer is enabled by default by it can be disabled
on the fly via fly via File->Options dialog.

1.0.2.6

October 8, 2018

Synchronized the version number of this document with the
release number.

Added context menu to the mail archive under Mail Tree,
summary mail in the Summary window and attachments.
Added new options to the File and View main menus.

Context menus enable user to print single, group or all mails to
CSV, Text or HTML files, sort mails by date, from, to, subject,
size and conversation groups, find and highlight all occurrences
of the searched text.

This release resolves the text encoding issues in the summary
window, i.e. text is now shown correctly.

Added image cache to properly handle inline images within an
email.

1.0.2.7

November 6,
2018

Fixed picture orientation in Picture Viewer.

Added mail message retrieval state in the status bar.

Improved performance of Picture Viewer to reduce flicker.
Added zoom slider and image dragging using mouse to Picture
Viewer.

1.0.2.8

December 14,
2018

- Version specific changes are tracked as shown in this line so
they can be more easily identified by the user.

- Added handling of embedded images declared incorrectly as
non inline attachments in the mail.

- Fixed incorrect text alignment in some cases when printing
group of mails to HTML;

- Added html2text conversion to print mails with only HTML
block and no plain text block.

- Added progress bar when printing mail archive to Text or
HTML or CSV files. The html2tewxt conversion is quite slow
and it was necessary to introduce the progress bar.




- Fixed race condition (introduced in 1.0.2.7) that could result in
message and mail summary out of sync.

1.0.3.0 February 26, 2019 | See what is new and what changed section.

2 What is new and what changed in version 1.0.3.0

2.1 What is new

N
W N

1.

LN WD

Added mail list editing capability to enable users to compose mail list by merging results of
multiple searches and/or by merging one or more user selected mails. See 6.16.

Added capability to archive search results to the archive file.

Added capability to archive the mail list composed by a user to the archive file.

Added capability to reload mail list composed by users from the archive file.

Added capability to select one or more mails and print, remove and/or copy.

Added option to directly print mails to user selected printer.

Added Advanced Find/Search capability. See 6.13.2.

Added option to set Message Window position to Bottom, Right or Left.

Added option to standard Find dialog to find all matching mails.

What changed

Updated status bar to display the number of the selected mail and the total number of mails.
Added “Find all occurrences” to the Find dialog.

Changed folder to house images embedded into mails from C:\Users\USER_NAME\
AppData\Local\Temp\mboxview to FolderHousingMailArchives/ImageCache. This is to
make sure folder persists reliably across computer restarts.




3 Feedback

To help to improve MBox Viewer, please post reviews what works and what doesn’t, create bug
reports and request for enhancements. Provide as many details as possible, such as country,
screenshots, etc.

4 Overview

MBox Viewer (or mboxview) is Windows GUI based program to view mbox files such as
Thunderbird Archives, Google mail archives or simple Eml files.

The mbox viewer is a simple but quite powerful email viewer that supports the following features:

large file support > 4Gb

fast parsing of mbox archives

quick access to all attachments

preview picture attachments

zoom in/out a picture

export of single mail in Eml

print all mails to CSV or Text or HTML files

print single mail to Text or HTML file or send to printer
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group all related mails as conversations

—_
S

. print related mails/mail group to Text or HTML file

f—
—_

. open single mail or group of related mails in a browser
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N

. find user defined text in mail’s message and highlight all occurrences

—_
w

. search the date, subject, sender, message text and text appendix

’_l
n

. sort by date, from, to, subject, size and conversation groups

[y
(@)

. support for mail’s header fields and body encoded with different character sets

—_
(=)}

. support for mail list editing capability to enable users to compose mail list by merging results of
multiple searches and/or by merging one or more user selected mails.

17. support to set Message Window position to Bottom, Right or Left.

5 Installation

The executable and the source code can be downloaded from Sourceforge or Github.

https://sourceforge.net/projects/mbox-viewer/files/

https://github.com/eneam/mboxviewer/releases

Download the executable package, the latest mbox-viewer.exe-v1.0.3.0.zip, to the working
directory and unzip. This will create the mbox-viewer.exe-v1.0.3.0 directory and the stand-alone
mboxview.exe executable and User Guide in that directory. No administrator privileges are
required.


https://github.com/eneam/mboxviewer/releases
https://sourceforge.net/projects/mbox-viewer/files/

6 Running the MBox viewer

The mboxview program can be executed by double clicking the executable from the explorer
window or from the command line by typing the command name and argument list to it.

6.1 Argument List Summary

The mboxview accept the following command line options.

-FOLDER=folderPath — the full path to the folder containing one or more mbox or eml files.
Persists in the registry across multiple runs.

-MAIL_FILE=fileName — full file path or just file name of mbox/eml file to load. If the full path is
not specified, the full path is created from the folderPath and the fileName. Doesn’t persist in the
registry across multiple runs.

-EXPORT_EML=y|n — enables or disables automatic export of eml files generated from mbox
archive. Improves traversing performance of mail if set to ‘n”. Persists in the registry across
multiple runs.

-PROGRESS_BAR_DELAY=seconds — search progress bar is activated when the search duration
lasts longer than the value set for PROGRESS_BAR_DELAY. If set to -1, the progress bar is
disables. Default value is set to 1 seconds. Persists in the registry across multiple runs.

If desired, instead of typing directly desired command line options, a simple .cmd or .bat file can be
created for convenience and run from the explorer.

6.2 Setting Options from GUI

The EXPORT_EML and PROGRESS_BAR_DELAY values can be changed on the fly at any
time from GUI.

Click on the “File” to open the drop menu and then select the “Options” option. The below dialog
will be presented. Set the desired values followed by OK button.

Note that if exporting of EML files is disabled, you can still export the eml file for the selected mail
by selecting “View EML” under the “View” drop menu.

Two options, “Show Charsets” and “Set Character Sets for Header Fields”, can help to properly
display header fields in the Message Window. See 6.15.1.1 for additional details.

The “Picture Viewer” check box enables/disables the dialog option to preview the picture
attachments, see 6.9 for additional details.

The “Time” option allows to display time as Local or GMT.



Options

Date format: () ddfmmfyyyy
(®) mm/dd fyyyy
O yyyyfmmjdd

Time:

(@) Local

() GMT

Search progress bar startup delay in seconds

Export EML: (®no (_)yes
Message Header Character Set IDs (0-65001)
from o subject
Lo | [o | [o |

Show Charsets: (@) no

- Picture Viewer

i yes

Cancel

6.3 Basic Use Case

Double click of the mboxview to start the viewer. The picture below shows the screen created by

the mboxview after few steps performed by a user. Mail Archive, Summary and Message windows

are initially blank after start-up. Steps to load a mail archive and display the content are described

next.

() mboxview
File Edit View Help
@ 7|7

=44 Mails
{3 apache.mbox
-3 attachment.mbox

@ All Maits O Find Malks User Selected Mals Help

| date (Local) from to subject

Mail List Auditing Dialog Bar

size(E) | °

shirish R <shirishag 75 @gmail.com>

31/12/2010 13:00

users @subversion.apache.org

nenbie subversion questions

? 04/01/201106:08 René_Hjortskov_Nielsen <rene@hjortsk... "Daniel Shahaf” <d.s@daniel.shahaf.name > Re: svnserve with corrupt timestamps and malformed text representation 8
12 linux-1996-05.eml 09/01/201108:13 "SKF." <zhang. fan.work@qq.com> “users” <users@subversion.apache.org>  svn: REPORT request failed on 'fsvn/tsvn/befocood 13
-3 linu-2001-07.eml * 07/12/201109:13 Péter_SZABADY <Peter . SZABADY@igo...  "users@subversion.apache.org” <users... merge error 19
12 linux-2002-02.eml 16/08/2016 14:54  <webster.brent@rogers.com> Subversion Users <users@subversion.a... My mixed revision working copy remains after a 'svn update Mail Summary List 18
16/08/2016 23:49  Ryan Schmidt <subversion-2016@ryand... webster brent@rogers.com Re: My mixed revision working copy remains after a'svn update’ . 7
18/08/2016 14:33  <webster brent@rogers.com> Ryan Schmidt <subversion-2016@ryand... Re: My mixed revision working copy remains after a 'svn update’ Window 21
Mail Archi 18/08/2016 14:55  Johan Corveleyn <jcorvel@gmail.com>  webster brent@rogers.com Re: My mixed revision working copy remains after a'svn update’ 10
ail Archive 04/10/2015 15:23 “Rainer Senn” <rainer.senn@senn-sdlut...  <users@subversion.apache.org> TortoiseSVN RepcBrowser: Feature request for Search function 7
Tree Window 05/10/2016 05:03  Torsten Krah <krah. tm@amail.com>> users@subversion. apache.org Ree: TortoiseSVN RepaBrowser: Feature request for Search function 7 v
ISubjer:t' newbie subversion questions .
Date: 31/12/201013:00 From: shirich I <shirichag75@gmail.com> To: users@subversion.spache.org Header of Message Window
Hi ~
This going to be a long post and actually a repost of what I asked
in Debian forum few days ago.
http://forums.debian.net/viewtopic.php?f=10st=58799 but got no answer.
This is from svn version 1.6.12 . q
Mail Message/Body
HL all, Window
I =m no programmer, Just & GSSr Who Somstimes downloads svn snapshots
or trunk builds and compiles them. My subversion skills are hence
extremely poor and hence need the forum expertise to know. Few
questions below -
2. Is thers a way in subversion when you ars downlosding some new
projsct progress as in megabytes downloaded STC. AR EXCEIDT 50 1T will
make clear what I am asking -
§ svn co https://pagesofadventur.svn.sourceforge.net/svnroot/pagesofadventur
pagesofadventur
s pagesofadventur/trunk
A pagesofadventur/trunk/.classpath
4 pagescfadventur/ctrunk/COMPILING
A pagesofadventur/trunk/compile.sh v
% pagesofadventur/trunk/LICENSE
Ready Mail Retrieval Complete  Mail 1 of 17

1. Click on the “File” to open the drop menu and then select the “Select folder...” option.
Browse to the folder containing one or more mbox and/or eml mail archive files and select

it. All valid mail archive files will appear in the Mail Archive Tree window.




B8 mboxriew - m] x
File Edit View Help
Select folder... F2 O Find Mais User Selected Ml Help
Refresh F3 from o subject szelkB) | *
Options... 00  shirish Rt <shirishag75@gmail.com>  users@subversion.apache..org newbie subversion questions
Print To > D8 René_Hjortskov_Nielsen <rene@hjortsk... "Daniel Shahaf™ <d.s@daniel.shahaf.name > Re: svnserve with corrupt timestamps and maiformed text representation 8
13 "BKFL" <zhang.fan.work@aq.com> “users” <users@subversion,apache.org>  svn: REPORT request failed on ' fsvn/tsvn/bc oo 13
ENb=stiaatbocine s Malky 13 Péter SZABADY <Peter.SZABADY®igo... users@subversion.apache.org” <users... merge error 19
Exit 4 <webster.brent@rogers.com> Subversion Users <users@subversion.a... My mixed revision working copy remains after a 'svn update’ 18
%9 Ryan Schmidt <subversion-2016@ryand... webster brent@rogers.com Re: My mixed revision working copy remains after a ‘svn update’ 7
18/03/2016 14:33  <webster brent@rogers.com> Ryan Schmidt <subversion-2016@ryand... Re: My mixed revision working copy remains after a ‘svn update’ 21
18/08/2016 14:55 Johan Corveleyn <jcorvel@gmail.com>  webster brent@rogers.com Re: My mixed revision working copy remains after a ‘svn update’ 10
04/10/2016 15:23 Rainer Senn” <rainer.senn@senn-solut... <users@subversion.apache.org> TortoiseSVN RepoBrowser: Feature request for Search function 7
05/10/2016 05:03  Torsten Krah <krah, tm@gmail.com > users@subversion. apache.org Re: TortoiseSVN RepoBrowser: Feature request for Search function 7 =
ISubject: newbie subversion questions
Date: 31/12/201013:00 From: shirish I <shirishag75@gmail.com> To: users@subversion.apache.org
Hi all, A
This is going to be & long post and actually a repost of what I asked
in Debian forum few days ago.
http://forums.debian.net/viewtopic.php?f=105t=58793 but got no answer.
This is from svn version 1.6.12 .
Hi all,
I am no programmer, just a user who sometimes downloads svn snapshots
or trunk builds and compiles them. My subversion skills are hence
extremely poor and hence need the forum expertise to know. Few
qusstions below :-
a. Is there a way in subversion when you are downloading some new
project progress as in megabytes downloaded etc. An exeerpt so it will
make clear what I am asking :-
$ svn co https://pagesofadventur.svn.sourceforge.net/svnrcot/pagesofadventur
pagesofadventur
A pagesofadventur/trunk
2 pagesofadventur/trunk/.classpath
4 pagesofadventur/trunk/COMPILING
L pagesofadventur/trunk/compile.sh v
F:N pagesofadventur/trunk/LICENSE
Select folder containing mails Mail Retrieval Complete  Mail 1 of 17

2. Click on one of the archive files to load all mails within the archive. Progress bar will
appear and automatically close after the selected archive is fully processed. Mail header

information of each email will appear in the Summary window.

Note that parsing of very large archive file may take some time since the mail archives are
text files and every character has to be examine one by one. However, subsequent loading
of mails is done from the index file created by the mboxview during the initial parsing of the
archive file. The created index file contains the header information, content meta data of
each mail in the archive file and the position of each mail within the mail file for quick
access to the mail message/body. Loading from the index file is much faster. The index files

have the .mboxview suffix.



e N - ' i

File Edit View Help

i o] 7] Al Mails Find Mails User Selected Mails Help

| =99 Mails ~
L. apachembox
i {3 attachment.mbox
£ linux-1996-05.eml
L) linux-2001-07.eml
L0 linux-2002-02.eml

ISubjer:t: <empty>

Please Wait X
Date: <empty> From: <empty>  To: <empty>

Parsing archive file to create index file ..

Ready Mail sox of 383

3. Left Click on one of the mails in the Summary window to show the Message/Body of that
email in the Message window. The mail retrieval state is shown on the status bar. Opening
a link within an external browser is recommended since running Java or scripts or ActiveX
controls is disabled in the internal browser to improve security.

6.4 Message Window Position

Message Window position can be set to Bottom, Right or Left via View — Message Window option.
After setting new position, mbox viewer needs to be restarted for the change to take effect.

When position is set to Right or Left, the mail address format will change to show mail name only
or mail address if the name is missing.

By default Message Window position is set to Bottom.



B8 mboxriew

File Edit View Help

= |7

=94 Mails
() apache.mbox
) attachment.mbox

) linux-1996-03.eml

{23 linux-2001-07.eml
{23 linux-2002-02.eml

Ready

@ AllMais

date (Local) +
31/12/2010 13:00
04/01/201108:08
09/01/201108:13
07/12/201109:13
16/08/2016 14:54
16/08/2016 23:43
18/08/2016 14:33
18/08/2016 14:55
04/10/2016 15:23
05/10/2016 05:03
05/10/2016 08:35
06/10/2016 03:42
26/07/2017 12:15
31/10/2017 19:06
07/02/2018 08:06
10/02/2018 02:59
19/02/2015 08:40

O Find Mals

from
shirish e
René_Hjortskov_...
gL
Péter_SZABADY
webster.brent
Ryan Schmidt
webster.brent
Johan Corveleyn
Rainer Senn
Torsten Krah

Daniel Shahaf
Johan Corveleyn
Daniel Shahaf
Vincent Lefevre
Mico Kadel-Garcia
Thorsten_schaning
Ignadio_Gonzélez...

User Selected Malk: Help

to

users
Danigl Shahaf

webster brent
Ryan Schmidt
webster brent
users

users

Rainer Senn
Daniel Shahaf
announce
users
Branko_Cibej
users

users

subject

newbie subversion questians

Re: svnserve with corrupt tmestamp. .
svn: REPORT request failed on Jsvn/...

merge error
My mixed revision working copy remai

Ret svn diff non-temporary files option
Does svn dlient binary hnors LANG ..
Not 5o cheap moves

Re: My mixed revision working copy re...
Re: My mixed revision working copy re...
Re: My mixed revision working copy re. .
TortoiseSVN RepoBrowser: Feature re...
Re: TortoiseSVN RepoBrowser: Featur. .
Re: TortoiseSVN RepoBrowser: Featur. .
Re: TortoiseSVN RepoBrowser: Featur. .
[ANNOUNCE] Apache Subversion 1.10...
Re: Error E160016 "... Is not a director ..

- a X

Subject: My mixed revision working copy remains after a ‘svn update’
Date: 16/08/2016 14:54 From: <webster.brent@rogers.com> To: Subversion Users <users@subversion.:
My mixed revision working copy remains mixed revision after multiple
attempts with 'svn update'.
Here's the final status output:

linux] »> svn st -u

X vobs/common/ cpCommon

X vobs/common/delCommon

x vobs/ots/broadcom/BCM_SDK_6.4.11

X

vobs/ots/osmé/Apps/HalServer/Drivers/1im400/Lim400APT

X vobs/ots/osmé/Target/PldInages/1imé00g_1

X vobs/ots/osm4/Tests/framework/tllprobe/mteraiv

x vobs/ots/uboot/u-boot-2008.08

X vobs/ots/uboot/u-boot-2013.01.01

X vobs/ots/wrlplat/tlab_gemuppc

X vobs/ots/wrl t/tlab_xeoncores0

X vobs/ots/wrlplat/tlabgorigs0_small

X vobs/prod

Status against revision: 13673

Performing status on external item at

*vobs/ots/osmé/Target/Pldimages/1im400g_1":

Status against revision: 87468

Performing status on external item at 'vobs/ots/uboot/u-boot-2009.06":

Status against revision: 475

Performing status on external item at 'vobs/common/cpCommon':

Status against revision: 101

Performing status on external item at 'wobs/common/delCommon':

Status against revision: 101

Performing status on external item at 'vobs/ots/uboot/u-boot-2013.01.01': v

Status against revision: 475

Mail Retrieval Complete Mail 5 of 17

6.5 Mail Context Menu

Right Click on a selected email in the Summary Window to open the context menu as shown below.

The “Print” context menu allows to print the selected email or group of emails (conversations) to

Text or HTML files, send to the user selected printer or to open in the external default application.

The name of the created file will be created based on the archive file name with the .txt or .html

suffix in the directory housing the archive file.

The “Find” option allows to find user defined text and highlight all occurrences in the Message

windows.

The “Find Advanced” options will start the advanced search dialog and pre-populate From, To and

Subject fields from the mail.

10



{2 linux-2002-02.eml
Open in Browser

Open Related Mails in Browser
Open Related Files Location
Find Text

ISubject: American Airlines Boarding Pass(es).
Find Advanced
Date: 05/11/201722:42 From: americ om  To: Joh om

(& mboxview
File Edit View Help
= 7| @ AllMails O Find Maks User Selected Malk: Heln
-4 Mails | datefocal)t  Fom w© subject sizekE)
~ 02 apachembox 04/01/201106:08 René_Hjortskov_Nielsen <rene@hjortsk... Daniel Shahaf™ <d.s@daniel.shahaf.name > Re: sunserve with corrupt timestamps and malformed text representation 8
S atachment mbox T neran
<[ linuee-1926-05.eml Print To >
{23 linux-2001-07.eml
Print Related Mails To >

American Airlines\‘ @

Reservations | ASdvantage Accourt | Fare Sales & Offers
You must print all attached boarding pass(es) before proceeding to the airport. This is not a valid mobile boarding
pass.

Gate and terminal may change. Check airpert monitors when you arrive or visit flight status

Thank you for choesing American Airlines.

- AAdVantage '

Unsubsoribe  Change your emai address  Wedsie vour email prefersnces  Ervacy ol

I.,vavmpdf

Mail Retrieval Complete

Mail 2 of 2

Ready

6.6 Mail Archive Context menu

Right click on the active mail archive under the Mail Archive Tree Window to open the context

menu as shown below.

@ mboxview O
File Edit View Help
& 57| (@ Al Mails (O Find Mails User Selected Mais Help
=49 Mails dete flocal) 1| from © subject size(KE)
-+ apache.mbox 04/01/201106:08 René_Hjortskov_Nielsen <rene@hjortsk... “Daniel Shahaf” <d.s@daniel.shahaf.name > Re: sunserve with corrupt timestamps and malformed text representation 8
=] o es@aa.com John. Smith@gmail.com American Airlines Boarding P )
£ linwx-1996-05 pring To N
{23 linux-2001-07
1) linux-2002-02 Sort By >
Open File Location
Properties
Refresh Index File
ISubject: American Airlines Boarding Pass(es).
Date: 05/11/2017 22:42  From: americanairlines@aa.com  To: John.Smith@gmail.com
O T,
AmericanAirlines "¢
Reservations | Adcvartage Accourt | Fare Seles & Offers
You must print all attached boarding passies) before proceeding to the airport. This is not a valid mobile boarding
pass.
Gate and terminal may change. Check airpert monitors when you arrive or visit flight status
Thank you for choosing American Airlines
AmericanAirlines Wy
ek AAdvantage g
Unsubscribe  Change your emailaddress  Update your email preferances  Privacy Folicy
r,EVlGVM‘de
Ready Mail Retrieval Complete  Mail 2 of 2

The context menu allows to print all email to CSV or Text or HTML files. The name of the created

file will be created based on the archive file name with the .csv or .txt or .html suffix in the
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directory housing the archive file. NOTE that mails will be printed according to the sort order in the
summary window.

Size of HTML file can be very large and opening in some browsers can be problematic. Microsoft
Edge and Google Chrome browser seem to perform best as far as handling large HTML files.

HTML to Text conversion was added in 1.0.2.8 to handle mails with HTML text block and no Plain
text. Conversion is quite slow and print time could increase significantly compared to 1.0.2.7 in
case a large number of conversions is required. Progress bar was added to indicate progress,
possibly slow progress.

All mails of the active archive can be sorted by date, from, to subject, size and conversations in the
Summary Window. This feature is the same as the left click on the selected column in the Summary
Window.

The “Properties” option shows the archive file location, size and email count

The “Refresh Index File” option will perform fresh parse of the archive file if needed.

6.6.1 Print to CSV File Dialog

When printing selected mail archive to CSV file, user can select what fields to export and the date
format.

Option to normalize content encoding is also available. Default encoding is set to UTF-8 and should
not be changed except possibly in special cases.

Select Fields to Export To CSV File hed

From To Subject Date |:| Message
Limit Message to N Lines l:l
Encodng:  (CJnone (@) UTFa

(O) User Defined Code Page Id: | 55001

Open "View" menu to view All Code Page Ids

Date format: (@) dd/mm/fyyyy

O mm/dd/yyyy
O yyyy/mmjdd
Time: (®Llocal (JGMT

Cancel

6.7 Mail Attachments

Mail attachments are shown at the bottom of the Message window. Note that the “*’ character may
appear in the first column for the associated mail to indicate presence of associated attachments. To
open location of attachments, double click on the mail in the Summary window or select

“View” - ”ViewEML” menu option. Temporary folder will open containing all attachments for the
email. Use standard Windows applications to view attachments.

12



You can also double left click to view attachments. Picture attachments will be viewed in the

Picture Viewer (if configured in the global Options) and other file types will be viewed by the

associated default Windows applications.

@ mbowview o =
File Edit View Help

= |7 @ All Mails O Find Mails User Selected Mails Help

=43 Mails | dateloca)s  fom o subject size(®)

-3 apache.mbox

- attachment.mbox
{2 linux-1996-05.eml

() linux-2001-07.em

() linux-2002-02.em

04/01/201106:08 _ René_Hiortsko
* 05/11/2017 22:42

jelsen <rene@hjortsk...
a.com

John. Smith @gmail.com

americanair

“Daniel Shahaf™ <d.s@daniel.shahaf.name > Re: svnserve with corrupt times
American Airines Boarding P

ips and malformed text representation

Subject: (/0) American Airlines Boarding Pass(es).

Date: (Windows-1252/1252) 05/11/2017 22:42  From: (/0) americanairlines@aa.com To: (/0) Jehn.Smith@gmail.com

Body: (UTF-8/65001)

Reservations | AfSdvartage Accourt | Fare Sales & Offers

American Airlines g, &

You must print all attached boarding pass(es) before proceeding to the airport. This is not a valid mobile boarding

Ready

6.7.1 Attachment context menu

pass.
Gate and terminal may change. Check airport monitors when you arrive or visit fight status mboxview - b4
Thank you for choosing American Airlines.
4« Temp » mbowiew o S |
Americanirlines Wy a
= Marme
mvwm@ AAdvantage §  # quidacces i
1 @ BYIGYM.pdf
B Desktop ~ #
B PTT20872.htm
& Downloads  #
Documents  #
Unsubscribe  Change your email address  pdate vour emal preferences  Privacy Policy ) Pictures -
" P >
BYIGUM.p .
I., 2items =
1
Mail Retrieval Complete Mail 2 of 2 1]

Right click on the selected attachment to open the context menu. The context menu allows to open

or print the attachment by the associated default application. You can also open the folder housing
the attachment. The selected attachment will be highlighted in the folder.

& Fr——— f" <d.sBdaniel.shahaf.name> Re: svrserve with
attachment.mbox —

a American Airlines

i) linux-1996-05.eml

{2 linux-2001-07.eml

{25 linux-2002-02.eml

= 05/11/2017 22 ail.com

arding P

(&) mboxview m] x
File Edit View Help
= %] 7] ® All Mails O Find Mails User Selected Mails Help
=43 Mails date (Local) t m aubject sze(iE)
~ @ apache.mbox 04/01/2011 06 Carrupt tmestamps and malformed text representation 8

ISubject: American Airlines Boarding Pass(es).

Date: 03/11/2017 2242 From: ameri To: John.

om

Reservations | Addvartage Account | Fare Sales & Offers
YYou must print all attached boarding passies) before proceed

Gate and terminal may change. Check airpert monitors when y

Thank you for choesing American Airlines.

M.M@

American Airlines\g @

ing to the airport. This is not a valid mobile bearding

ou arrive o visit fliaht status

Amesican Airfines

AAdvantage \'\

Unsubscribe  Change your email address.

Open

Undste vour email preferences

Privacy Policy

B Print

Ready

Mail Retrieval Complete

Mail 2 of 2

Open File Location
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6.8 Inline Image Cache

The mboxview will create the cache of inline images to support images embedded directly into the
mail body/message. The cache is created during the initial parsing of the mail archive file. Separate
cache folder is created per each archive file (assuming at least one inline image was found) in the
FolderHousingMailArchives/ImageCache folder. If the inline image cache is missing for any
reason, try to refresh the index file by selecting “Refresh Index File” context option on the
respective file archive.

6.9 Picture Viewer

Double left Click on any attachment to start Picture Viewer dialog, example below.

&3 niagara.jfif - O x

The Picture Viewer supports files with the png, jpg, jpeg, jpe, gif, bmp, ico, tif, tiff, jfif, emf, wmf,
dib suffixes.

The NEXT and PREV controls enable user to browse all picture/image attachments associated with
the selected email. You can select specific attachment to be displayed. You can later browse through
all picture attachments.

The ROTATE control allow to rotate clockwise the current/visible picture.

The ZOOM control allows to zoom in/out picture. Click on ZOOM to enable/disable zooming.
Slide to right to enlarge an image, slide to left to shrink. Enlarged image can be dragged using the
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left and scroll buttons of the mouse. Click ZOOM to disable zooming and reset the image to
original size.

The PRINT control allow to print via default application.

The Picture Viewer is enabled by default but it can be disabled via FILE — Options dialog. Setting
persists in the Registry across multiple runs.

All attachments are also accessible by double clicking on the selected mail in the Summary window
or by selecting “View” - ”ViewEML” menu option.

6.10 Mail Navigation
Click on a specific mail in the Summary window and use UP, DOWN keys to move to the next or

previous mail respectively.

Use HOME key to jump to the first mail. Use END key to jump to the last mail.

6.11 Mail Sorting

The Summary window is divided into 6 columns: attachment indicator, date, from, to, subject and
mail size. Each column can be sorted by clicking on the column title. Subsequent click on the same
column title will reverse the sorting rule. By clicking on the attachment indicator title, emails are
sorted by conversations and mark by different colour as shown below.

Mail can also be sorted via the mail archive context menu or by selecting “File”->“Sort By” menu
option.

(&) mboxview - ] x
File Edit View Help
= 1|7 @ Al Mails O Find Mails User Selected Mails Help
43 Mails + date (Local) from to subject seetE) | A
(i pachenbo 31/12/2010 13:00  shirish FRFIY <shirishag75@gmail.com pache.org nenbie subversion questions 7
{3 attachment.mbox 04/01/201106:08 René_Hjortskov_Nielsen <rene@hjortsk... Daniel Shahaf" <d.s@daniel.shahaf.name > Re: svnserve with corrupt timestamps and malformed text representation 8
15 linu-1996-05.eml 09/01/201108:13 SkFL" <zhang.fan.work@qq.com> “Users” <users@subversion.apache.org>  svn: REPORT request failed on'fsvn/isvn/bcfocoad 13
- linux-2001-07.eml |+ 07/12/201109:13 _Péter SZABADY <Peter SZABADY@igo... “users@subversion.apache.org” <users... merge error 19
2 linux-2002-02.ml 5) 5 14:54 _<webster brent@rogers.com> Subversion Users <users@subversion.a... My mixed revision working copy remains after a 'svn update'
16/08/2016 23:49  Ryan Schmidt <subversion-2016@ryand... webster.brent@rogers.com Re: My mixed revision working copy remains after a 'svn update" 7
18/08/2016 14:33  <webster.brent@rogers.com> Ryan Schmidt <subversion-2016@ryand... Re: My mixed revision working copy remains after a 'svn update' 2
18/08/2016 14:55 Johan Corveleyn <jcorvel@gmail.com>  webster brent@rogers.com Re: My mixed revision working copy remains after a 'svn update’ 10
04/10/2016 15:23 "Rainer Senn” <rainer.senn@senn-solut...  <users@subversion.apache.org> TortoiseSVN RepoBrowser: Feature request for Search function 7
05/10/2016 05:03  Torsten Krah <krah. tn@gmail.com> users@subversion.apache.org Re: TortoiseSVN RepoBrowser: Feature reguest for Search function 7 v

ISubject: My mixed revision working copy remains after a 'svn update’

Date: 16/08/2016 1454 From: <webster.brent@rogers.com> To: Subversion Users <users@subversion.apache.org>

My mixed revision working copy remains mixed revision after multiple attempts with 'swvn update'. ~
Here's the final status output:

[linux] »» svn st -u
vobs/common/ cpConmon
vaobs/common/dclCommon
vaobs/ots/broadcom/BCH_SDK_6.4.11
vobs/ots/osmé/Apps/HalServer/Drivers/1ime00/Limd00APT
vobs/ots/osmé/Target/Pldimages/1ime00g_1
vobs/ots/osm4/Tests/framework/tllprobe/mteraiv
vabs/ots/uboot/u-boot-2009.06
vobs/ots/uboot/u-booc-2013.01.01
vobs/ots/wrlplat/tlab_gemuppc
vobs/ots/wrlplat/tlab_xeoncore50
vobs/ots/wrlplat/tlabgorigs0_small
vabs/prod

tatus against revision: 13673

R R R

Performing status on external item at 'vobs/ots/osmé/Target/PldImages/lim400g 1':
Status against revision: 27468

Performing status on external item at 'vobs/ots/uboot/u-boot-2009.06': v
Status against revision: 475

Ready Meail Retrieval Cemplete Mail 5 of 17
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6.12 Dynamic Column Resize

Columns in the Summary windows are automatically resized when the window is resized.

However, if columns are resized manually, some of the columns may no longer be present in visible
area/window.

You may need to use the scroll bar to see missing columns, otherwise maximize and then restore the
window to see all columns within the Summary window again.

6.13 Mail Searching

Mbox viewer supports two search options, i.e. basic Find and advanced Find.

The basic Find option allows users to specify single keyword for searching across header fields,
mail text and attachments.

The advanced Find option allows user to specify keyword per each header field, mail text and
attachments.

6.13.1 Basic Find

The basic Find option allows users to specify single keyword/string for searching across header
fields, mail text and attachments

Users can configure the search scope by selecting all or subset of the from, to, subject, message and
text attachments options.

Click the “Edit” drop menu and select “Find” option to configure and start the search. Alternatively
the CTRL+F will also present the search dialog.

The search dialog box allows user to specify the search string, whether to match the whole word,
whether the search is case sensitive, configure the search scope, the start and end dates to consider
for filtering, the Next/Previous search direction and whether to highlight all occurrences of the
matched text.

Note that the Next search start with the oldest email while the Previous search starts with the latest.

The search logic simple, i.e. mail is considered a match if the search string is found in any of the
checked fields I that mail.
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Find X

Find what: || | | oK |

[ whole ward Caze sensitive Eariee]

[ Highlight all eccurences in Message

Search scope
From To Subject [JMessage []Atachments

I Filter dates:
start dater [12/31/2010 |

end date: [ 2/15/2015 |

[IFind all ozcurences

Search Direction

() previous (®) next

To repeat the search in order to find the next matching mail, click the “Edit” drop menu and select
“Find again” option, or select F3 key.

If “Find again” or F3 key is selected without prior “Find” or CTRL+F, the search dialog box will
be presented to a user.

6.13.1.1 Find All Occurrences Option

User can check “Find all occurrences™ to find all matching mails. Highlighting of all keyword
occurrences is not supported in this case. Matched mails will be displayed under the Find Mails List
and the corresponding button in the dialog bar will be highlighted. User can left click on All Mails
button to switch mail list back to All Mails.

The basic Find can also be run while in the Find Mails list and while in User Selected Mails list
when the list is enabled.

Find X

Findwhal:|macwei || ok |

[Jwhole word [ Case sensitive Caree]

[ Highlight all occurences in Message
Search scope
From To Subject []Message [ Attachments

[T Filter dates:

start date: | 7/ 242000
end date: | 7/30/2007

Find all occurences

Search Direction

() prewvious (®) riest
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B8 mboxriew

File Edit View Help

& ¢

=43 Mails
{£) apache.mbox
) attachment.mbox

(23 linux-1996-05.eml

{9 linux-2001-07.eml
1) linux-2002-02.eml

Ready

O AllMais @ Find Mals User Selected Malk: Help

date (Local) + from to subject

02/07/2001 10:06
02/07/2001 11:05
05/07/2001 08:14

“Macie] W. Rozycki” <macro@ds2.pg.gd. .
Ralf Baechle <ralf@oss.sgi.com>
"Maciej W, Rozycd” <macro@ds2.pg.od...

Harald Koerfgen <Harald.Koerfgen@home. . linux 2.4.5: A DECstation HALT interrupt handler
“Madiej W. Rozycki” <macro@ds2.pg.gd... Re: linux 2.4.5: A DECstation HALT interrupt handler
Ralf Bagchle <ralf@uni-koblenz.de> linusc 2,4.5: sysmips(MIPS_ATOMIC_SET) is broken (yep, again...)

05/07/200106:35 “Macie W. Rozyci” <macro@ds2.pa.0d... Ralf Baechle <ralf@oss.sai.com> Re: st does not wark.,

05/07/200109:27  Florian Lohoff <flo@rfcs22.0rg> “Maciej W. Rozycki” <mado@ds2.pg.od... Re:linux 2.4.5: _ATOMIC_SET) is broken (vep, again...)
05/07/2001 10:08 “Maciej W. Rozycki” <macro@ds2.pg.gd... Florian Lohoff <fo@rfca22.0rg> Re: linux 2.4.5: sysmips(MIPS_ATOMIC_SET) is broken (yep, again...)
05/07/2001 12:51 Jun Sun <jsun@mvista.com> “Maciej W. Rozycki” <macro@ds2.pg.gd... Re: linux 2.4.5: sysmips(MIPS_ATOMIC_SET) is broken (yep, again...)
05/07/2001 13:23 “Maciej W. Rozycki” <macro@ds2.pg.od...  Jun Sun <jsun@mvista, coms> Re: linux 2.4,5: sysmips(MIPS_ATOMIC_SET) is broken (yep, again...)

06/07/200106:42 “Maciej W. Rozycki” <macro@ds2.pg.gd... "Houten KH.C. van (Karel)” <vhouten...

o
ki

: Tilegal instruction

NI

size(KE)

I’

12/07/200107:05 “Maciej W. Rozycki” <macro@ds2.pg.gd... Karsten Merker <karsten@excalibur.col...  Re: gpm-support for serial DECstation mouse (VSXXX-AA) ©
ISubject: (/0) linux 2.4.5: A DECstation HALT interrupt handler

Date: (Windows-1252/1252) 02/07/2001 10:06 From: (/0) "Maciej W. Rozycki* <macro@ds2.pg.gda.pl>  To: (/) Harald Koerfgen <Harald Koerfgen@home.vm.de>, Ralf Baechle <ralf@uni-koblenz.de>
Hi, ~
Following is a minimal implementation of a HALT interrupt handler for
DECstations. The handler resets a system (invokes a warm restart) after
the HALT button or, in case of the MAXINE, the HALT seguence of keys is
pressed. The patch should ke COK to apply.

Maciej
+ Maciej W. Rozyciki, Technical University of Gdansk, Poland  +
+ e-mail: macro@ds2.pg.gda.pl, PGP key availsble +
patch-mips-2.4.5-20010627-halt-basic-0
diff -up --recursive -—new—f linux-mips-2.4.5-20010627.macro/arch/mips/dec/int-handler.S linux-mips-2.4.5-20010627/arch/mips/dec/int—handler.S
—-- linux-mips-2.4.5-20010627.macro/arch/mips/dec/int-handler.S Thu Jun 14 04 19 2001
+++ linux-mips-2.4.5-20010627/arch/mips/dec/int-handler.S Sun Jul 1 00:24:21 2001
B8 -230,14 +230,6 @@ spurious:

dec_intr_fpu: PANIC("Unimplemented FPU interrupt handler")

1%
- % Halt interrupt v
_ sy

<

Mail Retrieval Complete Mail 1 of 47

6.13.2

Advanced Find

The advanced Find option allows user to specify keyword per each header field, mail text and

attachments.

Users can configure the search scope by selecting all or subset of the from, to, subject, message and

text attachments options.

Click the “Edit” drop menu and select “Find Advanced” option to configure and start the search.

The Find Advanced is also available as menu option for the selected mail. Right click on the mail

and select Find Advanced option. Mbox viewer will pre-populate From, To and Subject fields in this

case.

Find Advanced X
= Find what Matchword  Match case
[AFrom ‘maun@dsz.pg.gda‘pl | ] O
o [ harald koer fgen@home. vm. de | g O
[Asubject ‘hnux 2.4.5:ADEcStanunHALTunoerrupthandh| O O
[OMessage ‘ | ]

[ Attachments ‘ | ]

[(setal Setall

Select filter rule
(From <——> To) attempts to match (John->Bob) and (Bob->John) mails

If some fields are not checked, for example From, then filter rule wil be reduced as follow:
<~ —>To and (Subject or Message or Attachments), i.e. {(Any -> Bob) or (Bob -> Any)) and ...

® (From <——> To) and (Subject or Message or Attachments)

(O (From —>To) and (Subject or Message or Attachments)

[ filter dates:

start

7/ 22001
end date: | 7/30/2001

Find all occurences Cancel
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Only checked fields are use by matching logic, search strings are ignored if present unless field is
checked.

The search logic is hard-coded for most common cases and described in the search dialog.

6.13.3 Search Reliability

Searching may not work as expected in all cases due to different character sets on input and in the
mails.

Base64 or “quoted-printable” text content blocks and text attachments are first decoded before the
search to eliminate false negative results.

Searching of the header fields is performed on the received raw data.

Raw mail data may contain plain text and/or html text blocks. Both encode the same/similar
content. If the mail contains plain text blocks, only plain text will be searched. If the mail doesn’t
contain any plain text blocks, the html text blocks will be searched.

False positive results may happen when searching text/html content blocks since the html tags are
not ignored when searching. The search string may match one of the html tags and result in false
positive match.

If possible, use ASCII characters only to compose the search string.

6.13.4 Special Search Key

The single character ‘*’, i.e. the star character can be specified as the search string to enable
traversing the subset of mails between the start and end dates.

6.13.5 Search Progress Bar

Search progress bar displays the progress along the configured search string and enables user to
cancel the search is so desired. The progress bar is not created unless a given search duration lasts
longer than the delay time controlled by -PROGRESS_BAR_DELAY command line option or
specified via GUI. Default value is 1 second.

6.13.6 Search Performance

Searching of header fields performs best since all fields reside in the memory.

Searching of messages and text attachments may take some time for very large files, say larger than
10-20 Gbytes. Search requires to read the content blocks from the email file and decode the content
when required. Worse case scenario is when the specified search string is not present in the mail
archive. When activated, the search progress bar shows the configured search string and enables
user to cancel the search is so desired.

Note that when searching of message and text attachments is configured, all mails will be sorted by
date first, except when sorted by conversations, to maximize search performance.
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6.14 Refreshing Archive Tree Window

If an additional mbox or eml file is placed in the already selected folder, the Archive Tree window
needs to be refreshed to see the new additions. This can be done by selecting “Refresh” option
under the “File” drop menu or by clicking on the button showed below.

) mbowview - o x
File Edit View Help

FENES @ All Mails O Find Mails User Selected Mails Help
=43 Wils | dateocalt  from to

0401/201106:08 Ren Nieken <renc@hjortsk...
box |+ p5/11/2017 2242 amer

and malformed 8

d
John.Smith @gmail. com

-2
£ linux-2002-02.em

Subject: <empty>
Date: <empty>  From: <empty>  Tor <empty>

Ready Mail xx of 2

6.15 Language (Character Sets) Support

6.15.1 Message Window

Different languages (character sets) are properly supported in the Message Window. This is thanks
to the Microsoft Web Browser emulation/control class integrated into the mboxview. The mboxview
generates the htm file from the mail’s body and Web Browser displays the generated file in the
Message window.

Display may not be correct if the character set for the mail’s body is not defined in the mail. To
resolve the incorrect display, you can try to apply different encoding by right clicking within the
window, selecting “encoding” and “more” options to apply different language.
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£ sttachment.mbox

= 05/11/2017 22192

& mborien

File Edit View Help

& 7] @ AllMais O FindMals User Salotad Mais Help

=43 Mails ! date QLocal) from to subject
£ 2pache mbox r .

-1996-05.eml
-2001-07.eml
- 2002-02.eml

American Arlines Boardng Pass(es).

Subject: Re: svnserve with corrupt and text

Date: 04/01/201106:08 From: René_Hjortskov_Nielsen

Thanks for your input.

I corzected the timestamps by maki
subversion-1.6.13/apr/cime/un:

APR_DE

struct timeval t

#/ revurn tvitv_sec =

= 1252141942240251 as 1.

11111011
apr_vime t  :
byt tves uhich can hold 4295567295 as the largesc positive numbe

ng some typecasts in

CLARE (apr_time_t) apr_time_now(void)

Since we are multiplying with 1000000 here, we get a huge number

-423521285 without typecasts, apparencly represen

I ended up debugging the subversion and apr code and found the soluction.

Back

Forward

Saveb.

Setas

Copy back
C + (long 1ong)T Selectall
+ tv.tv_usec:

& Paste
Create shorteut
Add to favorites...
View source

g and with my cypecast

0 10011001 00000011 11100110 11000001 10010|

Ready.

6.15.1.1

Encoding > Auto-Select
Print... Western European (Windows)
i * Unicode (UTF-8)
Refresh Central European (1S0)
Properties More 2

® Left-to-right document

Right-to-left document

Header of Message Window

Arabic (ASMO 708)
Arsbic (0OS)

Arabic (150)

Arabic (Windows)

Batic (150)

Baltic (Windows)

Central European (DOS)
Centrol European (Windows)
Chinese Simplified (GB18030)
Chinese Simplified (G82312)
Chinese Simplified (HZ)

Chinese Traditional (BigS)

Cyrillic (KOIB-U)
Cyrillc (Windows)

Greek (150)
Greek (Windows)

Hebrew (0OS)
Hebrew (50-Logicall
Hebrew (1S0-Visual)
Hebrew (Windows)

Japanese (Auto-Select)
Japanese (EUC)
Japanese (Shift-JIS)
Korean

Thai (Windows)
Turkish (150)

Turkish (Windows)
User Defined
Vietnamese (Windows)

Western European (150)

1]

>

The text of the mail header fields is displayed correctly as long as the corresponding field encoding

type is present in the email.

&) attachment.mbox
£ linux-1996-05.eml

12011 06
1/2011 08:13

cov_Nielsen <rene@hjortsk.
zhang fan. work@qg. com >

£ linux-2002-02 el

(B mboxview

File Edit View Help

=% 7] @ AllMais O Find Mails User Selested Mals Help

=83 Mails | date(oe) s from o subject
© spachembox 31/12/2010 13:00  shirish TS <shirish: I ch

upt timestamps and maffo

 text representation

size(KB)

-

2£ [09/Jan/2011:22:00:28 +0800)

(T request failed on 'Jsvn/isv/bc)s 3
{5 tinux-2001-07.eml | = 07/12/20110:13  Peéter_SZABADY <Peter SZABADY@igo... “users@subversion.apacheorg” <users... merge eror 19
16/08/2016 19:54  <webster brent@rogers.com> Subversion Users <users@subversion.a... My mixed revision working copy remains after  'sun update’ 18
16/08/2016 23:43  Ryan Schmidt 16@ryand... webste m Re: working copy remains after a'svn update’ 7
18/08/2016 19:33  <webster.brent@rogers.com> Ryan Schmidt <subversion-2016@ryand... Re: My mixed revision working copy remains after a 'svn update’ 2
18/08/2016 14:55  Johan Corveleyn <jeor vebter Re working copy remains after a'svn update’ 0
04/10/2016 15:23 “Rainer Senn” che.org Feature request for Search function 7
05/10/2016 05:03  Torsten Krah <krah.tm@omal.com: che Res for Search function 7 v
Subject: sun: REPORT request failed on “/svn/isun/be/xo00c
Date: 09/01/201108:13  From: "3L" <zhang fanwork@qg.com>  Tos "users” <users@subversion.apache.org>
Hi, all. ~
Here is my preblem:
When I run svn log on my repository which version is 1.6.x with Apache 2.2 on Windows 2003 have suddenly begun getting an error message in their log
windows:
Error REPORT request failed on */[path ; 21008 200 0K (hoep:// [serve
ed the log of apache, get like this
9/Jan/2011:22:00:25 +0800] "t
00/ Jan/2011:22:00:28 +08
9/ Jan/2011:22:00: 28 08!
Jan/2011:22:00:28 +08
TJan/2011:22:00:28 +08
Jan/2011:22:00:28 +08
09/Jan/2011:22:00: 28 08! TP/
/b1n/21008 ETTE/1
1" 207 637
09/Jan/2011:22:00: 28 +08! / v

Ready

Meail Retrieval Complete
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Two global options can be used to address incorrect field presentation in the Message Header in

case the field encoding is not present in the email. Missing field encoding type may or may not be a

problem. It should not be a problem if the default/local character set installed on your computer

matches the original encoding of the header fields. It might be an issue if you are receiving emails

from different countries.

As shown below, you can see all encoding/character sets applied to the header fields by enabling

“Show Charsets” option. To enable, select “Options” from the “File” drop menu and enable “Show

Charsets”.
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B8 mboxriew - m] x
File Edit View Help

- @ All Mails (O Find Maiks User Selected Mk Help
-84 Mails date (Local) + from o subject szelkB) | *
© apache.mbox 31/12/2010 13:00  shirish AT <shirishs i.com pache.org nenbie subversion questions 7
{3 attachment.mbox 04/01/201106:03 _René_Hjortskov_Nielsen <rene@hjoartsk... "Daniel Shahaf” <d.s@daniel.shahaf.name > Re: svnserve with corrupt timestamps and malformed text representation g
~2 linux-1996-05.em 09/01/201108:13 SKFL" <zhang.fan.work@qa. com> “ysers” <users@subversion.apache.ora> _ svn: REPORT request failed on 'fsvn)lsvn/bcfooond.
(23 linux-2001-07.eml | "= 7/12/301109:13 Péter_SZABADY <Peter,SZABADY@®igo... ‘users@subversion.apache.org” <Users... merge error 19
12 linux-2002-02.eml 16/08/2016 14:54  <webster brent@rogers.com> Subversion Users <users@subversion.a... My mixed revision working copy remains after a 'svn update’ 18

16/08/2016 23:45  Ryan Schmidt <subversion-2016@ryand... webster brent@rogers.com Re: My mixed revision working copy remains after a ‘svn update’ 7
18/03/2016 14:33  <webster brent@rogers.com> Ryan Schmidt <subversion-2016@ryand... Re: My mixed revision working copy remains after a ‘svn update’ 21
18/08/2016 14:55 Johan Corveleyn <jcorvel@gmail.com>  webster brent@rogers.com Re: My mixed revision working copy remains after a ‘svn update’ 10
04/10/2016 15:23 “Rainer Senn” <rainer.senn@senn-solut... <users@subversion.apache.org> TortoiseSVN RepoBrowser: Feature request for Search function 7
05/10/2016 05:03  Torsten Krah <krah, tm@gmail.com > users@subversion. apache.org Re: TortoiseSVN RepoBrowser: Feature request for Search function 7 =

ISubject: (/0) svn: REPORT request failed on '/svn/!svn/bc/xooc
Date: (Windows-1252/1252) 09/01/201108:13  From: (gbk/54936) "H{FL" <zhang.fanwork@qq.com>  To: (gbk/54936) "users” <users@subversion.apache.org>  Body: (ghk/54936)

Hi , all. 2
Here is my problem:

When I run svn log on my repository which version is 1.6.x with Apache 2.2 on Windows 2003 have suddenly begun getting an error message in their log
windows:
Error REPORT request failed on ' /(path_te_repol/lsvn/be/21008° 200 0K (http://[server_namel)

Then I checked the log of apache, get like this:

+0800] 7
+0800] °
+0800]

BEEEBEEREE BN
i i P R TRt b s
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If the field text presentation is not correct, you can try to configure character set (or so called code
page according to Microsoft terminology) for the selected header fields and see if that helps. Per
field code pages can be configured via Options dialog box. Note that the user provided encoding
doesn't override encoding in the email, if present, which is denoted by the code page greater than
zero. Code Page set to zero indicates missing or unknown character set.

If you change the code page value(s) in the Options Dialog box, you need to refresh the selected
email by going up and down (or down and up).

All Windows supported code pages are listed in chapter 7 or can be viewed in the external Browser
by selecting “View” — ”View Code Page Ids”.

The character set information appears after the field title and is formatted as “(character set
name/code page)”. The “*” star character is appended after the code page if the user specified code
is applied). Example “(UTF-8/65001%*)”.

The character set information after the “Date:’ title shows the local/default character set installed on

your computer.

6.15.2 Summary Window

Mail header fields are displayed correctly as long as the corresponding field encoding type is
present in the email.

6.16 Mail List Auditing

Mail list auditing capability enables users to compose mail list from all mails by merging results of
multiple searches and/or by merging one or more user selected mails.
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To support list auditing, the Mbox Viewer maintains 3 internal mail lists:

* All Mails list is populated from the selected archive file under the Mail Tree.

» Find Mails list is populated by the search results. User can run Find Advanced dialog or set
the Find All Occurrences option in the Find dialog.

* User Selected Mails list is composed by a user from the mails in the All Mails and Find
Mails lists.

Each internal mail list has associated button in the dialog bar located next to the tool bar. When a
particular mail list is shown in the Mail Summary Window, associated button is highlighted.

Access to the User Selected Mails list is disabled upon startup and the associated Button gray out. It
can be enabled by the user to perform simple list auditing if desired by selecting View->User
Selected Mail List to enable/disable.

When User Selected Mails list is enabled, additional mail menu options will also be enabled such as
Copy Selected Mails to User Selected Mails.

Content of the User Selected Mails list is controlled by the user. User can merge search results with
the content of the User Selected List.

User can run the search multiples time and merge results multiple times with the User Selected List.
Search results can be pruned before merging.

In addition, user has an option to select/highlight one or more mails in the Summary Mail Window
and copy to the User Selected Mails list.

Standard Windows method is used to select and highlight multiple mails, i.e. Shift+Left Click and
CTRL+Left Click.

Merging/copying process will not create duplicate mails in the User Selected List.

User can select and highlight one or more mails in the Summary Mail Window and remove from the
active list. Mails can't be removed from the All Mails list.

All Mails list content persists until new mail archive is selected.
Find Mails list content persists until new search or when All Mails list is invalidated.

User Selected Mails list content persists until cleared by the user or when All Mails list is
invalidated.

6.16.1 Mail List Archiving

Find Mails list and User Selected Mails list content can be saved to new mbox archive files.
Archive file will be created in the same folder as the All Mails main archive.

Archive file created from the Find Mails list will be created by appending _FIND suffix to the base
name of the main archive file name.

The _USER suffix will be appended when creating archive file from the User Selected Mails list.
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For example, if the main mbox archive file from gmail is called "All mail Including Spam and
Trash.11.09.2018.mbox", then created archive file will be named "All mail Including Spam and
Trash.11.09.2018_USER.mbox."

When creating archive file for User Selected Mails list, the mbox viewer will also create file with
the list of all mails for that archive, for example "All mail Including Spam and
Trash.11.09.2018_USER.mbox.mboxlist."

The mail list file allows user to reload the last archived mail list into the User Select Mails. Reload

can be requested at any time including after restart of the mbox viewer.

After mbox viewer is restarted or when User Selected Mails List is empty, User Selected Mails list

can be restored when All Mails list is active.

When User Selected Mails list is active, it can be reloaded when List is not empty.

7 Windows Code Page Identifiers

The table below shows the supported character sets/code pages by Windows platform. The list is
based on the following link.

https://msdn.microsoft.com/en-us/library/windows/desktop/dd317756(v=vs.85).aspx

CodePage Name Display Name

37 IBM037 IBM EBCDIC (US-Canada)
437 1BM437 OEM United States

500 IBM500 IBM EBCDIC (International)
708 ASMO-708 Arabic (ASMO 708)

720 DOS-720 Arabic (DOS)

737 ibm737 Greek (DOS)

775 ibm775 Baltic (DOS)

850 ibm850 Western European (DOS)
852 ibm852 Central European (DOS)
855 IBM855 OEM Cyrillic

857 ibm857 Turkish (DOS)

858 IBM00858 OEM Multilingual Latin I
860 IBM860 Portuguese (DOS)

861 ibm861 Icelandic (DOS)

862 DOS-862 Hebrew (DOS)

863 IBM863 French Canadian (DOS)
864 IBM864 Arabic (864)

865 IBM865 Nordic (DOS)

866 cp866 Cyrillic (DOS)

869 ibm869 Greek , Modern (DOS)

870 IBM870 IBM EBCDIC (Multilingual Latin-2)
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https://msdn.microsoft.com/en-us/library/windows/desktop/dd317756(v=vs.85).aspx

CodePage

Name

Display Name

874

windows-874

Thai (Windows)

875 cp875 IBM EBCDIC (Greek Modern)
932 shift_jis Japanese (Shift-JIS)

936 gb2312 Chinese Simplified (GB2312)
949 ks_c_5601-1987 Korean

950 big5 Chinese Traditional (Big5)

1026 IBM1026 IBM EBCDIC (Turkish Latin-5)
1047 IBM01047 IBM Latin-1

1140 IBMO01140 IBM EBCDIC (US-Canada-Euro)
1141 IBMO01141 IBM EBCDIC (Germany-Euro)
1142 IBMO01142 IBM EBCDIC (Denmark-Norway-Euro)
1143 IBM01143 IBM EBCDIC (Finland-Sweden-Euro)
1144 IBMO01144 IBM EBCDIC (Italy-Euro)

1145 IBM01145 IBM EBCDIC (Spain-Euro)

1146 IBM01146 IBM EBCDIC (UK-Euro)

1147 IBM01147 IBM EBCDIC (France-Euro)
1148 1IBM01148 IBM EBCDIC (International-Euro)
1149 IBM01149 IBM EBCDIC (Icelandic-Euro)
1200 utf-16 Unicode

1201 unicodeFFFE Unicode (Big-Endian)

1250 windows-1250 Central European (Windows)
1251 windows-1251 Cyrillic (Windows)

1252 Windows-1252 Western European (Windows)
1253 windows-1253 Greek (Windows)

1254 windows-1254 Turkish (Windows)

1255 windows-1255 Hebrew (Windows)

1256 windows-1256 Arabic (Windows)

1257 windows-1257 Baltic (Windows)

1258 windows-1258 Vietnamese (Windows)

1361 Johab Korean (Johab)

10000 macintosh Western European (Mac)

10001 X-mac-japanese Japanese (Mac)

10002 x-mac-chinesetrad Chinese Traditional (Mac)

10003 X-mac-korean Korean (Mac)

10004 X-mac-arabic Arabic (Mac)

10005 x-mac-hebrew Hebrew (Mac)

10006 X-mac-greek Greek (Mac)

10007 x-mac-cyrillic Cyrillic (Mac)

10008 x-mac-chinesesimp Chinese Simplified (Mac)
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CodePage

Name

Display Name

10010 X-mac-romanian Romanian (Mac)

10017 x-mac-ukrainian Ukrainian (Mac)

10021 x-mac-thai Thai (Mac)

10029 X-mac-ce Central European (Mac)

10079 x-mac-icelandic Icelandic (Mac)

10081 x-mac-turkish Turkish (Mac)

10082 X-mac-croatian Croatian (Mac)

12000 utf-32 Unicode (UTF-32)

12001 utf-32BE Unicode (UTF-32 Big-Endian)
20000 x-Chinese-CNS Chinese Traditional (CNS)
20001 x-cp20001 TCA Taiwan

20002 x-Chinese-Eten Chinese Traditional (Eten)
20003 x-cp20003 IBM5550 Taiwan

20004 x-cp20004 TeleText Taiwan

20005 x-cp20005 Wang Taiwan

20105 x-1A5 Western European (IA5)

20106 x-IA5-German German (IA5)

20107 x-IA5-Swedish Swedish (IA5)

20108 x-IA5-Norwegian Norwegian (IA5)

20127 us-ascii US-ASCII

20261 x-cp20261 T.61

20269 x-cp20269 ISO-6937

20273 IBM273 IBM EBCDIC (Germany)

20277 IBM277 IBM EBCDIC (Denmark-Norway)
20278 IBM278 IBM EBCDIC (Finland-Sweden)
20280 IBM280 IBM EBCDIC (Italy)

20284 IBM284 IBM EBCDIC (Spain)

20285 IBM285 IBM EBCDIC (UK)

20290 IBM290 IBM EBCDIC (Japanese katakana)
20297 IBM297 IBM EBCDIC (France)

20420 IBM420 IBM EBCDIC (Arabic)

20423 IBM423 IBM EBCDIC (Greek)

20424 1BM424 IBM EBCDIC (Hebrew)

20833 x-EBCDIC-KoreanExtended IBM EBCDIC (Korean Extended)
20838 IBM-Thai IBM EBCDIC (Thai)

20866 koi8-r Cyrillic (KOI8-R)

20871 IBM871 IBM EBCDIC (Icelandic)

20880 IBM880 IBM EBCDIC (Cyrillic Russian)
20905 IBM905 IBM EBCDIC (Turkish)
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CodePage Name Display Name

20924 IBM00924 IBM Latin-1

20932 EUC-JP Japanese (JIS 0208-1990 and 0212-1990)
20936 x-cp20936 Chinese Simplified (GB2312-80)
20949 x-cp20949 Korean Wansung

21025 cpl1025 IBM EBCDIC (Cyrillic Serbian-Bulgarian)
21866 koi8-u Cyrillic (KOI8-U)

28591 is0-8859-1 Western European (ISO)

28592 is0-8859-2 Central European (ISO)

28593 is0-8859-3 Latin 3 (ISO)

28594 is0-8859-4 Baltic (ISO)

28595 is0-8859-5 Cyrillic (ISO)

28596 is0-8859-6 Arabic (ISO)

28597 is0-8859-7 Greek (ISO)

28598 is0-8859-8 Hebrew (ISO-Visual)

28599 is0-8859-9 Turkish (ISO)

28603 is0-8859-13 Estonian (ISO)

28605 is0-8859-15 Latin 9 (ISO)

29001 x-Europa Europa

38598 is0-8859-8-i Hebrew (ISO-Logical)

50220 is0-2022-jp Japanese (JIS)

50221 csISO2022JP Japanese (JIS-Allow 1 byte Kana)
50222 is0-2022-jp Japanese (JIS-Allow 1 byte Kana - SO/SI)
50225 is0-2022-kr Korean (ISO)

50227 x-cp50227 Chinese Simplified (ISO-2022)
51932 euc-jp Japanese (EUC)

51936 EUC-CN Chinese Simplified (EUC)

51949 euc-kr Korean (EUC)

52936 hz-gb-2312 Chinese Simplified (HZ)

54936 GB18030 Chinese Simplified (GB18030)
57002 x-iscii-de ISCII Devanagari

57003 x-iscii-be ISCII Bengali

57004 x-iscii-ta ISCII Tamil

57005 x-iscii-te ISCII Telugu

57006 X-iscii-as ISCII Assamese

57007 X-iscii-or ISCII Oriya

57008 x-iscii-ka ISCII Kannada

57009 X-iscii-ma ISCII Malayalam

57010 X-iscii-gu ISCII Guyjarati

57011 x-iscii-pa ISCII Punjabi
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CodePage Name Display Name
65000 utf-7 Unicode (UTF-7)
65001 utf-8 Unicode (UTF-8)

7.1 Handling Unknown Code Page Names

In a few cases, mboxview will map unknown code names to the equivalent code names supported

by Windows.

Unknown Code Name Mapped To Code Name
gbk GB18030

cpl252 Windows-1252

ascii us-ascii

cp819 1is0-8859-1

latinl is0-8859-1

latin2 1s0-8859-2

big-5 big5

SJIS shift_jis
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